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We do the work to make it easy for you!

What is It? Computerized filing.
To help you use a computer to manage the same kind
of information that you keep in card files and filing
cabinets--such as student records, mailing lists,
memberships, research notes, phone numbers, etc.

Who is it for? Two kinds of people.
« new users ... who want to use computers without
having to invest large amounts of money or time.

- those who need a simple filer ... even
experienced computer users sometimes need a
quick, simple, low-cost yet elegant filing system.

Who developed it? Stoneware.
Since 1980, a leader in powerful, computerized filing

systems.

Vital Statisti
Maximum file size: 320,000 characters
Maximum number of fields: 100
Maximum field size: 3,000 characters
Maximum record size: 3,000 characters

Save report designs; produce reports on screen, printer,
or disk (for use with a word processor); print mailing labels;
3 ways to find records; 3 sorts with subtotals per report.

Hardware required: Atari ST with one disk drive;
Black and white or color monitor;
Printer recommended.
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REGISTERED LICENSEE
AND USER INFORMATION

IMPORTANT

Stoneware has developed this software product and has licensed the
Atari Corporation to market the Atari ST version of this product worldwide.
In no sense are the two firms engaged in a joint venture or partnership.
Because of the nature of the U.S. copyright laws, Stoneware retains
ownership of this software.

Stoneware and Atari have provided to you statements of their warranties
and limitations on warranty and liability. Stoneware has provided to you a
copy of its License Agreement.

These will form a contract between you or your organization and
Stoneware, and between you and Atari. In order to maintain our ownership
of our product, we must insist that you return the attached registration
card. You may not legally use this product until you do so.

TECHNICAL SERVICES

Stoneware provides a range of technical services. One of the most
important of these is technical support. Our technicians are available to
answer questions, either by telephone or by letter, which our users may
have regarding use of our products. If you are interested in our technical
services, please return the registration card. We will send to you
information concerning our technical services.

INFORMATION ABOUT OTHER PRODUCTS

Stoneware has developed a range of products for a number of different
computers. We will develop many more products in the future, including a
number for the Atari ST. We would like to tell you about them, but we
need to know where to send the information.



STONEWARE®

LICENSE AGREEMENT

Stoneware grants to you a non-exclusive license to use the enclosed
software product subject to the terms and restrictions of this License
Agreement. Stoneware retains title to this software.

The enclosed software and documentation are copyrighted. You may
not copy or otherwise reproduce any part of this software or
documentation except to load the program into the computer as an
essential step in using it, and you may make copies of the program for use
as working backups on the same computer. You may physically transfer
the software from one computer to another, provided that you do not use
the software on more than one computer at a time. You must purchase
one copy of this program and the documentation for each computer on
which you use this program at one time. You may not transfer this software
over a network. You may not distribute copies of this software or
documentation to others. This software may not be modified or translated,
nor may you publish sections of the documentation, without written
permission from Stoneware.

STONEWARE LIMITATIONS
ON WARRANTY AND LIABILITY

Stoneware makes no warranty regarding the quality, reliability, and
accuracy of this software. Atari Corporation assumes these
responsibilities, subject to its separate warranty statement. Stoneware is
responsible only to Atari Corporation to correct demonstrable and
significant errors in the software. Stoneware makes no warranty regarding
the disk on which the software is recorded, nor regarding any other
physical element of this product. Your sole recourse is with the Atari
Corporation.

This warranty information and the Software License Agreement shall be
governed by and construed according to the laws of the State of California.
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UNDERSTANDING
FILE
MANAGEMENT

INTRODUCTION

This chapter is written especially for those of you who are learning for the
first time how to manage information using a computer. We believe that
the most important concepts of computerized filing are the same as
those in paper-based filing systems. The easiest way to learn these
concepts is to clarify the basics about managing information the familiar
way, on paper.

In this chapter, we'll say that you are the librarian of the Happy Valley
School. We will first create a catalog of books. Then, we will describe
what you did that is common to both paper and computerized filing
systems. Each section ends with a few definitions that apply to all filing
systems. These concepts and terms are not limited to DB Master One.

A LIBRARY EXAMPLE
A NEW CARD CATALOG

As the new librarian in the Happy Valley School, the superintendent calls
you into his office on your first day. He says, "We had a fire in the
library last night, but don't worry, none of the books burned."

"That's good," you reply. But soon you discover that what burned was
the card catalog that described each of the 2,000 books and told the
reader where to find it. Your immediate task is to create quickly a new
catalog that contains information to help students find books.

What is that information? For each book, you need: author's name,
book title, publisher, date published, number of pages, type of book,
subject matter, and a special library index number.



On what will you keep this information? You decide to use small index
cards. Carol in the print shop agrees to produce 2,000 of these cards

overnight.

How will you store these cards? You have visions of note cards spilling
out into the hall where the superintendent will see them. Frank, the
woodworking teacher, offers to build a card file with drawers that will
accommodate the 2,000 cards.

Author:

Title:

Publisher:
Date Published:

Type of book:

Subject:

Index No.

Author/Title
CL - COK

E— D

Basics

Field

Form

Blank form

What you've done so far is to make a form and a
file. You decided: what information is needed,
what form you would use to store that information,
and how you would store the information once the
form is filled in.

Each kind of information.

The paper (or whatever) on which information is
. placed.

A form that has fields placed on it, but does not yet
have specific information filled in.

File A storage device which, at a minimum, has one
blank form, a name, and the capacity to hold a
number of filled-in forms.

Files can be as small as a card box
or as large as a row of fiing cabinets.

2,000 CARDS TO FILL IN!

Early the next morning, you meet with Mrs. Brown, who teaches English
Literature, and relate your concern about having to fill in 2,000 cards.
She offers to lend you her class for a day.

Carol delivers the 2,000 blank forms just as you and your "volunteer"
workers arrive at the library. You assign a section of shelves to each
student, and they start filling in the information for each book. Later in the
day, you notice that a student has written in "The Rutabagas of Omar
Khayam." The superintendent would not be amused, so you correct the
card.
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ng Author: }(*MWA'M, OmaR Index No: 89/.5
0]

Title: “KoBaaT oF OMAR KHANYAM
PLeTe ORiGWAL E. Fitzaermd “Teansianon

Publisher: MesPEARE HoUSE
Published: [95!
M< Type of book: Remy No. of pages: /59

Subject: (£Rs100) POETRY

Basics In this section you entered data onto your
forms. You took blank forms and filled them in with
real information. And you changed information
which you knew to be incorrect.

Data Specific information entered on a form.
Record A filled-in form.
Editing Making changes to the fields of a record.

PUTTING YOUR CARDS IN ORDER

One day later all the cards are filled in. Now you have 2,000 cards, in no
particular order. How could anyone find a specific card in that mess?

So you and your volunteers begin sorting the cards into alphabetical
order by the author's last name. Boxes are brought in to hold cards for
each letter of the alphabet, and the students toss the cards into the
appropriate boxes.

The next day, your volunteers first pull out any cards that were put into
the wrong box and then sort the cards in each box into alphabetical
order. Finally, they move the cards over to the cabinet drawers. Now
the filing cabinet is complete!

Basics You organized the records before storing
them in the file. There has to be an order to a
file if people are going to be able to use it.

Sort The process of rearranging records according to the
data in a certain field.

File order The order in which records are stored in a file.

NOW STUDENTS CAN FIND BOOKS!

The library now has an author card file! When Mrs. Brown assigns a term
paper on Shakespeare, you know you're ready to help. Your library has
45 cards for works by Shakespeare. Students can go to the file drawer
marked "SC-SP," flip through the cards, and find all the cards for
Shakespeare.

Snowk Spa
Shad E=Shake
Sel |
= Scott
Author/Title
SC - SP
o&e—vo
Basics One of the most important reasons to have a file is

to be able to find a particular record or a
group of records quickly.

Finding records The process of searching through a file to find one
or more records.



ARE OUR MODERN LITERATURE BOOKS There are four major things to consider when you prepare a report:

CURRENT? Report fields The fields that are included in the report.

: (for example: name, title, date of publication, etc.)
To show your appreciation to Mrs. Brown, you ask if there is any

particular information she needs from the new card catalog. Report records The selected records that are used.

(in the example: books published after 1960)
"Definitely," she says. " | want to show the superintendent that the !

library needs to update its modern literature collection. So I'd like to
show him all books in the library published after 1960, and how many are
fiction compared to the other types of books." !

Report sort The order in which records are printed.
(by date of publication)

Report form The design or layout of a report.

As the color drains from your face, you mutter, "Two thousand books on (in columns)

the shelf. Two thousand cards in the file organized by author's last
name."

You are going to have to look at every card in the file to get Mrs. Brown's
information.

At the top of several sheets of paper, you write the different types of

books (fiction, reference, etc.). Then, you divide all the cards among the fmc&“g Aceords

volunteers and tell them to look at each card until they find a book

published after 1960. Then, they are to look at the type of book and

write down the author's name, book title, and date of publication on the

appropriate sheet. A day later the task is finished.

"Well," says Mrs. Brown, "I appreciate this list, but | really need the book e =

titles written down by their date of publication, not by the author's

name." Author/Title]
SC-SP

You spend half of the next day rearranging the list to meet Mrs. Brown's me

requirements.

Basics Sometimes you may need to see information from
more than one record at a time. You may need a - : :
listing of certain fields from selected records. And P"”’Q‘Mg Acpiadd
you may need to have that information sorted S o '

differently than the file order. What you need from : ;
the file is a report. These are two ways to look at the information

in your files.




CHANGES AND CAUTION

A memo from the superintendent arrives on your desk. He tells you that
a vital piece of information has been left off of the cards. He wants the
date on which the library acquired the book and how it was acquired
(purchased, gift, etc.).

There is no convenient place on your cards to add this new information.
You will have to print up new cards and transfer over all the information
from the old cards.

The superintendent has a second concern. He wants to insure that all
of your commendable work doesn't turn to ashes in case there is ever
another fire.

This issue is easier to resolve, but almost as time consuming. After you
fill in the new cards, you will photocopy all the cards in the file, taking care
to keep them in order so that they don't need to be alphabetized again.
Then, you will put the copies in the storage room of the basement.

Basics No one sets up a file correctly the first time!
Usually, you will have to add and delete fields in
order to make your file what you want. Even then,
you will find that information isn't stable. Your
information needs will probably change over time.
You may even decide to change the file order. You
will have to redesign the file.

A file used in your work often represents a very
significant investment. You will want to copy your
file in case the one you work with gets damaged

and cannot be used.
Redesign Changing the form after it has been set up.
Backup A complete copy of your file.

DB MASTER
ONE
BASICS

INTRODUCTION

This chapter describes a few computer basics you'll use when you start
and leave DB Master One and how to get on-screen help whenever you
need it.

REFERENCE SYMBOLS

In the remaining sections of this manual the following symbols have
been used to make the instructions clear and brief:

[} The pointer (screen location of the mouse).

Place the k on an object.

Click the mouse button once.

Click the mouse button twice quickly.

Hold the mouse button down.

[Point], and move the mouse, pulling the
object under the k with the mouse.

Save Instructions using menu options show the option in
bold text.

[} An arrow in the margin points to special notes for

your attention.



USING THE COMPUTER

We assume that you know the basics about using your computer.
Standard operating techniques are covered in the Owner's Manual
provided with your computer.

Changing
screen
resolution

Mouse

Keyboard
commands

lcons

o=

EDIT

P AGE
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The operating system lets you select different
screen resolutions depending upon the type of
monitor you are using. Files for DB Master One can
be created on low, medium, or high resolution.
When you create a file in one resolution, you cannot
open it using a different resolution setting.

Only the left mouse button is used with
DB Master One.

Most of the menu options can be started directly
from the keyboard instead of with the mouse. The
character A on the screen represents the Control
Key. Hold down [Control] while pressing the letter
shown on the menu. The special function keys are
not used with DB Master One.

DB Master One uses two types of icons to start
different functions in place of keyboard commands.

Menu Help icons: At the bottom of each menu
heading are pictures that represent the functions
available from that menu. the icon to get Help
about the functions of that menu. (Help is also
available by pressing the [Help] key, as described
below.)

Beport Form icons: Four layouts are available for
producing reports. (See Report Forms in the next
section.) When you are designing a report,
the report form you want before you tell DB Master
One what information will go into the report.

GETTING STARTED

Making a
working copy

Starting
DB Master One

Leaving
DB Master One

Help whenever
you heed it!

Use the system disk provided with your computer to
make a working copy of DB Master One.

Instructions for copying a disk can be found in the
Atari ST Owner's Manual under "Making a System
Backup Disk."

As soon as you've made your copy, store the
master program disk in a safe place, away from your
working area. If the working disk becomes
damaged, you'll still have the original from which you
can make another working disk.

Because there are two parts to DB Master One,
there are two ways to start the program:

Making a file: When you are ready to design a new
form, insert the DB Master One program disk. From
the desktop, MAKEONE.PRG and

Open from the File menu. (You can also

the program name to openiit.) Follow

the same steps when you want to redesign a

DB Master Onefile that is already on the disk.

Using a file: To begin adding information to the file,
from the desktop, USEONE.PRG and
Open from the File menu (or the
program name). Atthe next screen (ltem Selector
Box), the name of the file you want to
use. The file is now open and ready for you to add
or change records and produce reports.

There is only one way to exit DB Master One
properly, whether you have created a new file or are
using an existing one: Quit from the File
menu. If you want to save your work, Yes at
the screen prompt before you exit.

Need help or a reminder about how to use part
of DB Master One? [Help] on the keyboard at

11



Making more
space available
for files
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any time to get a quick refresher. To select a topic,
the one you want. Flip through all the Help
screens by clicking the buttons marked [More] or
[Back] at the bottom of each screen.

After you have created a file, you can remove
MAKEONE.PRG from the disk to leave more room
for your DB Master Onefiles. You will still have the
master program disk with the original MAKEONE
program to create other files or copy back onto the
disk if you want to redesign the file.

THE
BUILDING
BLOCKS

INTRODUCTION

There are five major building blocks in file management. This chapter will
describe how each of these building blocks are used with DB Master
One. Most of what you will do with DB Master One will be focused on
these five parts:

Field An individual item of information.

Form The screen display on which your fields have been
placed.

File Information stored on identical forms, which have

been saved on the disk and given a name. The file
includes any report designs that have been set up.

Record A form in which data has been entered.

Report Selected information from the file presented visually
in a specified format. Reports can produce
information from certain fields of selected records,
sorted in a specific order.

With DB Master One, these building blocks typically are used in the
following order.

First, decide what fields you want, and place them on the screen where
you want. By placing fields on your screen, you are, in effect, designing
aform. When you save the form, you make a file. Next, open that file
and start adding records by typing in the information you want to save.
You will also use the file to find specific records and possibly to delete
records. After records are stored in your file, you will produce reports.

13




FIELDS
w

Label box

Data box

Move box
Size box

Field style

14

Desk File Edit Splat Options

Design Forn

The first of the two parts of a field, the label
identifies the kind of information that will be typed
in the data box. A field label may be up to 64
characters.

The second part of a field, it holds the specific data
which is typed into the field. The data may be up
to 3,000 characters.

The black box on the lower left edge of the field,
which is used to drag the field to a different place.

The black box on the lower right edge of the field,
which is used to make the data box larger or smaller.

The color, size, and appearance of the label and the
data. Style is set from the Options menu.

There are three questions to answer about fields when designing your

form:
1. What fields?

2. What order?

3. Where put?

Write down all of the fields (items) that you will want.

Put the most important field first. The data box in
the upper left hand corner of your screen will be
used to determine how the information is stored.

Fields may be placed anywhere on the screen.
Follow the steps described below.

Fields can contain any kind of information. If fields contain only numeric
data, totals will be calculated automatically in certain kinds of reports.
(See Report Forms in the next section).

Dates

Time

To sort properly, always enter dates: YY-MM-DD.
For example, January 27, 1986 is 86-01-27. You
can use any "separator” (such as "-" or "/"), but
always use the same one. Or use the Date Splat to
create three separate fields. (See the Splat Menu in
the next section.)

To sort properly, enter time as HH:MM and use a
24-hour clock.  For example, 7:45 PM is 19:45.
If you want to sort on hours, make hours and
minutes separate fields.

15




PLACING FIELDS ON THE SCREEN

Desk File Edit Splat Options
Design Form

* e o» P

o

(<]

-

! where you want a field to start.

Type the field label.

Options if you want to change label and
data style.

4. and [iag) the size box if you want to

change the number of characters that will
fit into the data box.

5. and the move box if you want to
move the field.

When you the size or move box, hold the k
on the box until you see that the field has an
"outline” around it.

© P

Three types of fields are available with DB Master One: fields with label
and data, label-only fields, and data-only fields.

Label-only
fields

Data-only
fields

Cut, Copy and
Paste fields

16

Used for titles, Type in a label. Then the size
box toward the label until the data box disappears.

Used for columns of data. where you want the
field to start. the size box until the data box is
the size you want. Do not type a label.

See MAKEONE: Edit menu in the next section.

FORMS

p/wgz\a/w(mm

Desk File\Edit Report Record

File order

Long Forms

Choosing the information by which your records will
be stored is the most important step in designing a
useful form.

Records are stored in the file based on the first
sixteen characters of data closest to the upper left
corner of the screen. Records are displayed in file
order, including those that match the example you
give when you are looking for a particular group. If
you print an unsorted report, it will be produced in
file order.

A form can be 100 lines long. To move to fields

which are below the bottom of the screen, use the
scroll bar on the right side of the screen.

17




FILES

A file is created when you save the form that you have been designing.
Every time you save your work on the same disk, the current file is
written over the previous one, completely replacing the previous one.

[2 Save your work often! As you make changes to the file, get in
the habit of saving your work regularly. Save from the File menu
and continue working.

[ Backup your files! At the end of each working session, make a
backup copy of your file. Save the file on your disk. Then, eject that disk
and put your "backup” disk into the drive. Save the file again.

[ Keep a formatted disk handy! If you save a file and learn that
it has grown too big to fit on the disk anymore, just put a new formatted
disk into the drive and Save from the File menu. If you do not

have another formatted disk available, you must delete records until your
file fits on the original disk.

18

RECORDS

prd
W&‘i%} Desk File Edit Report Record

Celtic Gaulconquered by Julius Caesar 58-51B.C.

Romansruledforabout 500 years. Long history of monarchy.
Frenchrevolution 1789-93 s ded bythe First Republic.
Sufferedtremendouslossesin World Warl.
Maintains overseas tenitoriesin Polynesia, Antarctica,

New Caledonia, etc.

mea,momm pn Neord]

You add records to a file by typing information in each field. You must
open USEONE.PRG before you can add information to the file. As you
collect this information, you can find and display all or specific records.

Moving from When filling in the form, [Return] to move

field to field from field to field across the screen. Or in any
field you want . To go directly to fields not shown on
the screen, the scroll bar and then in the
field when it appears on the screen.

Adding, Editing, See the USEONE: Edit menu in the next section.

Finding, and Fields may be left blank. Unfilled spaces in a record
Deleting are not included in the count of characters stored.
FINDING SOME RECORDS

DB Master One provides three ways you can look for particular records.
Also, you can indicate three different examples for each search.

DB Master One then goes through all the records in the file and displays,
in file order, those that match the examples you have entered. It
ignores whether the characters entered are in upper or lower case.

19




To look for particular records from the file, first select a field on which you
are going to search. Then, specify which type of search you will use.
Finally, you enter an example of what you want to find. Repeat these
steps a second and third time if you need to make a more specific search
through the file. The examples below use the Travel file shown in this
manual to find records for specific countries.

Equals

Between

Contains

More than one
match example

20

The first part of a field matches the example.

If yousay: Country (field ) equals (type of search)

UN (example),
you will find:  United Kingdom and United States

The data in a field falls in the range between two
examples.

If you say: Country is from SL to TA,
you will find:  Switzerland and Taiwan

The data anywhere in a field includes the match
example.

If you say: Notes (field) contains monarchy,
you willfind:  Long history of monarchy
(in the record for France)

If examples are in different fields, records must
match ALL examples.

If you say: Continent gquals Europe and
Population is from 53.9 million tg 60 million,
you will find:  France and Germany

If examples are in same field, record must match
EITHER example.

If you say: Continent equals North America and
Continent equals South America,
you will find:  Brazil, Canada, and United States

REPORTS

ek [

8 1ey COURTRY NITES Page S
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Jan 18, 1986 4:45PM POPULATION Page 1
Country Population
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Name - France
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Reports let you look at information from all or selected records at the
same time. DB Master One allows you to produce reports in any of four
forms. Samples of these four forms are shown above. Reports can be
displayed on the screen, printed, or saved on the disk.

Form

Fields

Records

Sort

Produce reports in any of four forms: Column,
Page, Record, and Mailing List. (See Report Forms
in the next section.)

Two of the forms (Column and Page) require you to
choose which fields are in the report.

Use up to three examples to choose which records
to include in your report when you only want to see
information from a particular group.

DB Master One can rearrange the order in which the
records will be shown in the report.

21




SORTED REPORTS

When no sort order is specified, records are printed in file order. You can

rearrange the order in which records are printed by selecting another field
as the first sort field.

In file order, a column report

_ Jan 18, 1986 4:45PM POPULATION Page 1
shows records for the Travel file oy ®e o peaten =
listed alphabetically by country
L Brazil 1247 8512
Canada 241 9976
Egypt 432 1001
France 539 547
India 700 3288
Italy 57.4 301
Japan 118 372
Mexico 72 1973
Spain 379 505
United Kingdom 55.9 244
United States 2265 9363
West Germany 61.2 249
1589.7 44018
Grand Totals for 13 records in this report,
Jan 18,1986 4:45 PM AREA Page 1
Country Population Area
Canada 241 9976
United States 2265 9363
Brazil 1247 8512
Australia 149 7687
India 700 3288
Mexico 72 1973
Egypt 432 1001
France $3.9 547
Spain 379 505
Japan 18 372 .
Italy 574 30 Y h g h f Id
S rndl o 3 ou can,change the sort field to
United Kingdom 559 244

T area, for example, and print a report
Orand Totl for 13 recor n tis rpert listing the countries from the
smallest to the largest in land area.

You can even sort your report
records first by the continent and

Jan 18, 1986 4:45PM  BY CONTINENT Page 1

then from the highest population ¥t e 3 o
to the lowest. In this case you
would get a subtotal when all the
countries of each continent were
listed. By adding these "extras," e e
you can have a report that looks e ey
like this: e
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MENUS
AND
DIALOG BOXES

INTRODUCTION

This section goes screen-by-screen through the two parts of DB Master
One. For easy reference, the page topics are shown in boldface in the

left margin.

Menus

Dialog boxes

and alert
messages

MAKEONE.PRG

The same menu bar is used throughout the process
of creating a new form or changing the design of an
existing form.

Desk File Edit Splat Options

Ee———= Designform ————

USEONE.PRG
These menu headings are displayed when you use
the file to manage records and produce reports.

Desk File Edit Report Record

E=——Use ONE: B\TRAVELONE==————

Dialog boxes function as described in the Atari ST
Owner's Manual. A dialog box appears when

DB Master One needs more information from you
and when you save or choose a file or a report
design.

23
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Desk Hle Edit \Splat /Options

NelX Design Form =—————1

MAKE FILE MENU
New New on the File menu to clear the entire

Redesign

Save

Quit
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screen so that you can start over.

Redesign to change an existing file. Then,
make changes exactly as you would change a new
form. If fields are deleted, any report designs using
those fields will also be deleted. If the data boxes
of any fields are shortened, you may lose data from
those fields.

Save stores your work on disk (thereby making a
file) and lets you continue. If the disk is full, or if you
want to save the form on a different disk, insert a
new formatted disk, and follow the screen
instructions.

Use Quit to return to the desktop.

Deskmwit Splat Options

Design form =———-+

ITEM SELECTOR

ACCOUNTS. ONE x
STOCKS .ONE
TRAVEL ONE _%ﬂ)’

PHONES X, ONE I

MDBMuﬁA&M.gz@mﬂam

ITEM SELECTOR BOX

Item Selector
Box

How do you get
this box?

File name

File selection

This box appears whenever you name or save a file.
Since it is produced by the operating system, not by
DB Master One, it is possible that this box could
change.

From the MAKEONE File menu, Save or
Redesign. From the USEONE File menu,
Switch Files or Save. This box also appears
when you open USEONE.PRG from the desktop.

Up to 11 characters may be used to name a file, 8
before the "." and 3 after. If you give a form the
same name as another one already on the disk,
DB Master One will replace the original file with the
current design.

To choose a file for redesign or use, its name

from the listing of files in the Item Selector Box, and
OK. Oryou can the file name.

25




W

3

EDIT MENU

Desk File Q3388 Splat Uptiqé;

fe”

Desk File Edit‘Splat Options

Hail?hg List
Checkbook
Collection

SPLAT MENU

Cut Field
Copy Field

Paste Field

Cut Text

Copy Text

Paste Text
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Cut removes a selected field from the form.
Use this before Paste to copy a field.

The most recent cut or copied field can be pasted
anywhere on the form. where you want the
field to start, then Paste. You can paste the
same field as many times as you want.

the mouse across the characters in a label you
want to delete and Cut Text.

the mouse across the characters in a label you
want to copy and Copy Text. Use this
before Paste Text to copy text.

in any field label: Then Paste Text to
put the most recently cut or copied text in the label.

Splat

Mailing List

Date

Warthogs

Other Splats

These are ready-to-use fields you can add
anywhere in your forms or use as instant forms.
where you want the Splat fields to begin and
then the Splat name. Splat field labels, sizes,
styles, and placement can be changed.

These fields are set up to print a mailing list. You
can edit them for other kinds of labels. Moving
these fields or changing their size will not affect the
form of the mailing label. If you delete any part of
this Splat, you will not be able to print mailing labels.

Three fields for files with dates that you want to sort
by year, month or day.

This very useful Splat form is for all the itinerant
warthog collectors in the world.

Several other Splats have been provided for your
use. These may change.
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Desk File Edit Splat

Label Styie 'm =——+——+4
Data Style

ABQO HELP

apperanet g/gmwwmm

OPTIONS MENU

Options
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Field labels and data can be set in different sizes,
colors and text appearance. The field label style can
be different from the data style.

Styles are set from the dialog box shown on the
next page. When you set a style for the field label or
data, the next fields you add will use those settings.
Fields already placed will not change.

Desk File Edit Splat __Dptim]s

CHOOSE LABEL STYLE

APPEARANCE

HICK

LIGHT
KEW

UNDERLINE
O outLine

\
et £

STYLE DIALOG BOX

Style Dialog
Box

How do you get
this box?

Color

Size

Appearance

This dialog box is used to set the color, size, and
appearance of the label or the data of a field.

From the MAKEONE Options menu, Label
Style or Data Style.

For color monitors, you may choose the color of the
label and the data.

Select the size of the label and the data. If you
choose a size that does not fit the space available, a
message will appear to tell you that it will not fit.

Text appearance can be mixed in any combination.
Text will be plain unless modified by another
setting. To undo a text appearance setting,
again in the same box.
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Suitch Files...
Save
Quit

USE FILE MENU

Record Count
% full

Switch Files

Save

Quit
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These numbers change as you add records to or
delete records from the file.

Switch Files to open a different file than the
one currently in use. the file you want from the
Item Selector box (described earlier) . If the screen
is not set at the same resolution you used to create
the file, you will not be able to open it.

Save stores your work on the disk and lets you
continue using your file. If the disk is full, or if you
want to save records on a different disk, insert a new
formatted disk and save.

Use Quit to return to the desktop.

Desk File EJR® Report Reco;,d/ W

RAVEL.ONE E

\4
Clear Field

9@@ HELP

EDIT MENU

Cut

Copy

Paste

Clear Field

To remove data from a field, the mouse across
the characters you want to delete and Cut.
Note: You can also delete selected data with the
[Backspace].

Use this with Paste. the mouse across the
characters you want to copy and this option.

where you want to place the most recent cut
or copied text. You can paste the same text as
many times as you want, and you can paste text into
other fields and other records.

Choose a field and this option to erase all the
data in a field.
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RAVEL.ONE

REPORT MENU

Design New Up to ten different report designs may be saved for
later use. This option is more fully described on the
following pages.

Edit You can change or delete existing reports. You may
replace the original design or save both the original
and the edited version. Choose the part of the
report you want to change and follow the same
procedures as used when designing a new report.

Print A report can be printed, displayed on the screen, or

saved on the disk as a text file to be used with a
word processing program.

32

REPORT CONTROL PANEL

Report
Control Panel

Form

Fields

Find
Sort

Saving the
report design

Reports contain four parts: Form, Fields, Find and
Sort. After you specify these parts, you give the
report a name.

What does the report look like? How will the
information be presented?

Which fields will be printed in the report and in what
order?

Which records will be included in the report?

In what order will the records appear in the report?
After the report parts are specified, whatever
you want to do next. A dialog box will appear asking

you to name the report. The report name is printed
as the report title and may be up to 23 characters.
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Use One:B:\TRAVEL.ONE=————+

ca

Capttal
Populatia

E

PAGE

XX

M Uw\ . Total this Field Total this Field
2
REPORT FORM % REPORT FIELDS
Column The field labels are printed across the top of the Report fields If you choose Record Form or Mailing List, the fields
page as column titles. Fields are printed in columns are automatically set and you do not need to specify
with one row per record so that data from a number them. If you choose either Column or Page Form,
of records can be presented on one page. A field you need to select which fields go into the report.
may be shortened to fit. Totals are automatically the fields in the order you want them to print.
calculated for numeric fields with 9 digits or less. a field again to remove it from the report
: : design. You cannot add label-only fields to report
Page Field labels are on the left margin of the page, and designs.
the data for each field is printed next to its label. All
of the data in each field is printed. Each record Column fields  As you [@ the fields for the report, a diagram at
printed starts on a new page. the bottom of the screen shows the width that each
. : : field will be printed. If you choose more fields than
Record This produces a copy of records which looks like the can fit on one line, the last characters of each field
You cannot print this form to the screen or store it
onthedisk, Page fields As you fields for the report, labels for those
ol 1 : 5 i1 th
Mailing List This form is only available when the Mailing List gﬁ g:sv:" Sl R b SR DA
Splat is included in the file. It is designed to print 2
standard one-across, six-line, pin-feed labels.
Fields left blank are not printed. This form will not
34 calculate any totals. 35




Desk File Edit {3188 Record

IR\ BETUEEN | CONTAIRS |
4
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REPORT RECORDS

Report records DB Master One prints all records in the file unless
you tell it to find a specific group. Find only if

you want your report to include a particular group of
records.

Particular records are selected for reports in the
same way as they are selected for viewing on the
screen. (See Find Records Dialog Box.) Three
methods of finding records are available: equals,
between, or contains. Three examples may be
given per report.

36

Print Subtotals
Start New Page

REPORT SORT

Sort field

Sort direction

Subtotals

New page

Sort number

Reports may be sorted by up to three fields. Sort
fields do not need to be included as print fields in
the report. the sort field on the form.

Sorts are normally from low to high numbers and
from letters A to Z based on the contents of the sort
fields chosen. You can reverse the order and sort
from Z to A and highest number to lowest.

Yes if you want to print subtotals. When the
data in the sort field changes, all fields that hold
numbers with 9 digits or less will be subtotaled.

Choose this option if you want to start a new page
when the data in the sort field changes.

When you finish with one sort, the next

number if you want a sort within that sort. You can
review or change other sorts by clicking the number
you want to find.
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Choose Report Send to:

Il countries I SCREEN | 2
tries b I l
ounlries by area T EDIT

|| My first report X

1|TV¥s per country - [ DELETE |

CHOOSE REPORT DIALOG BOX

Choose Report
Dialog Box

How do | get
this box?
Screen

Print

Disk

Edit

Delete
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This box appears whenever you select an existing
report design to edit or print. Ten report designs
may be stored.

From the USEONE Report menu: Edit or
Print.

Display the report on the screen. the [Space

Bar] to pause a report and [Return] to stop it.

Send the report to a printer. the [SpaceBar]
to pause a report and [Return] to stop it.

Store the report on the disk for use as a text file.

Choose the report you want to work with.
Edit to modify an existing report design.

Delete to remove a report design from the
file.

e il
fo o

Desk File Edit Report f{IOIai]
¢ Ad

Find Sonme...
Next
Previous

Delete...

RECORD MENU

Add

Find All

Find Some

Next

Previous

Delete

Any time a blank form is displayed on the screen,
you can fill it in and add a record to the file.
Add to put a blank form on the screen. in the
field where you want to add data. [Return] to
move to the next field.

This allows you to look at all records, one at a time.

Find Some when you're looking for one
record or a particular group of records.

Next to see the next matching record in the
file, and repeat this step to see each subsequent
record.

If you want to look again at records you have found,
Previous to back up.

To remove a record permanently from the file, find
the record and Delete.
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FIND RECORDS DIALOG BOX

How do | get
this box?

Choose fields

Equals
Between

Contains
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This box appears when you Find Some
from the Record menu.

You find particular records by typing in an example
of what you are looking for. the first field that
has data you want to find. the kind of match
(Equals, Between, or Contains). Type in the
characters you want to match. Repeat these steps if
you have a second and third example. To change
an entry, the number button and go through
the same steps. Erase to delete an

example. Find when you are ready to see

the first record in the group.

The example matches the beginning data of a field.
The data falls within a range given in your example.

The example appears anywhere in the field.

A
Add record, 39

appearance (text), 29

INDEX

Atari ST Owner's Manual, 10, 11

B

Backspace key, 31
backup, 8, 18
basics, 2, 4-8

between search, 20, 40

black box, 14

building blocks, 13-22

C

Clear Field, 31
click, 9

close file (see Quit, Save)

color, 29

Column form, 21, 34, 35
contains search, 20, 40

Control key, 10

Copy, 31

Copy Field, 26

copy disk, 8, 11

Copy Text, 26

count
characters, 19
records, 30

cursor, 19

Cut, 31

Cut Field, 26

Cut Text, 26

D
data, 4, 13

erase, 31

numeric, 15
data box, 14

first data, 15
data-only fields, 16
data style, 28, 29
dates, 15

Splat, 15, 27

DB Master One, 9, 11, 19, 21, 23

leaving, 11

MAKEONE, 11, 12, 23

starting, 11

USEONE, 11, 19, 30

Delete record, 40
Delete report, 38
Design New, 11, 32
desktop, 11

dialog boxes, 23

field style, 29
find records, 40

ltem Selector , 25

report name, 38

disk, 18
making more space on, 12

formatted, 18
program, 11
save reports, 32

drag, 9, 26, 31
double click, 9

E

Edit, 26, 31
editing, 4
equals search, 20, 40

exit DB Master One, 11

F

field, 2, 13, 14, 1

blank, 19
color, 29
data-only, 16
dates, 15

delete (see Cut Field)

edit, 4, 31
label, 14, 28
label-only, 16

label style, 14, 28, 29

move box, 14

moving field to field, 19
report fields, 7, 21, 33, 35

not on screen, 19
numeric, 15
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placing, 16
redesign, 24
size box, 14
Splat, 27

style, 14, 28, 28
time, 15
unfilled, 19

file, 2,3, 18

backup, 8
name, 25

New, 24
Redesign, 8, 24
Save, 24

save current, 18
selection, 25
size, 18

file order, 5, 15, 17

unsorted reports, 22

filing systems, 1

basics, 2, 4-8
computerized, 1
paper-based, 1

finding records, 6, 19-20, 36, 39-40

between search, 20, 40
contains search, 20, 40

equals search, 20, 40

more than one example, 20
upper/lower case characters, 19

form, 2, 3, 13, 17

blank form, 3
Column, 21, 34, 35
filled-in, 4

length, 17

Mailing List, 21, 35
Page, 21, 34, 35
Report, 7, 21, 33, 35

GH
Help key, 11

icon, 10

icons

help menu, 10
report form, 10

ltem Selector Box, 11, 25

JK

keyboard commands, 10
keys, 10
Backspace, 31
Control, 10
Help, 11
special function, 10

L

label-only fields, 16
label style, 14, 28, 29

leaving DB Master One, 11

M
Mailing List, 27, 34
form, 21, 34
MAKEONE, 11, 12, 23
match example, 20
menus, 11, 23
MAKEONE, 23-29
USEONE, 23, 30-40
mouse, 9, 10
click, 9
double click, 9
press, 9
drag, 9
move box, 14

N
name, 25
file, 25
report, 33
New , 24
new page, 37
numeric data, 15

o)

open file, 11, 19
operating system, 10, 25
Options, 28

P

Page form, 21, 34, 35
Paste, 31

Paste Field, 26

Paste Text, 26

pointer, 9

Print, 21, 32, 38
new page, 37
subtotals, 37

program disk, 11

Q

Quit, 11, 24, 30

R
record, 4, 7, 13, 19, 39-40
add, 39
count, 30
Delete, 39
Edit, 31
file order, 5
find, 5, 19-29, 36, 39, 40
Next, 39
Previous, 39
report records, 7, 21
Save, 30
sorted, 5
Record form, 21, 34, 35
Redesign, 24
reference symbols, 9-10
report, 7, 13, 21, 32-38
choose, 38
Column form, 21, 34
Delete, 32, 38
Design New, 32
Edit, 32, 38
fields, 7, 21, 33, 35
form, 7, 21, 33, 34
name, 33, 37
Page form, 21, 34, 35
Print, 32, 38
records, 7, 21, 36
Record form, 21, 34
sort, 7, 21, 33, 37
subtotals, 37
title, 33
totals, 15
Report Control Panel, 33
Report form, 10, 21, 33, 34
Report Name dialog box, 37

S

Save, 18, 24, 30

screen resolution, 10

scroll bar, 19

searches, 19
between, 20, 40
contains , 20, 40
equals, 20, 40

more than one example, 20

selected records, 7

sizebox, 14

size field, 14

size text, 29

son, 5, 21, 22, 33, 37
field, 22, 37
direction, 22, 37
number, 37

Splat, 27
Date, 15, 27
Mailing List, 27, 34
Warthogs, 27

style, 28, 29

subtotals, 37

Switch Files, 25, 30

symbols, 9-10

-

totals, 15, 34
time, 15

U

upper case characters, 19
USEONE, 11, 19, 23

vw
Warthogs, 27

XYZ
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